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Resource Library

Using the Resource Library
On this tab you find an assortment of resources to help you learn more about Cisco Unified 
Communications.

• Cisco Unified Communications System Description

• Cisco Unified Communications System Release Notes

• Network Topology Resources

• Ordering Guides

• Troubleshooting Individual Components

• Component Resources

• Configuration Command Files

• System Test Results

• End-of-Sale and End-of-Life Products

• Cisco Unified Communications System Demo

Cisco Unified Communications System Description

For Release 6.0(1):

Cisco Unified Communications System Description (right-click to download PDF)

Cisco Unified Communications System Release Notes

System Release Notes for IP Telephony: Cisco Unified Communications System, Release 6.0(1)

Network Topology Resources
This topic provides topology resources that you can use to document network plans. Specifically, it 
includes:

• Microsoft Visio Network Topology Diagrams as individual Microsoft Visio files
7-1
munications System for IP Telephony Release 6.0(1)

http://www.cisco.com/univercd/cc/td/doc/systems/unified/uc601/sysdesc/sd601.pdf
http://www.cisco.com/univercd/cc/td/doc/systems/unified/uc601/relnotes/rnipt601.htm


Chapter 7      Resource Library
  Network Topology Resources
• How to Use Microsoft Visio Drawings Efficiently, guidelines for best practices in using Microsoft 
Visio files

Microsoft Visio Network Topology Diagrams
You can download zip files containing Visio drawings of the logical and physical topologies for IP 
telephony. Table 7-1 identifies the Visio drawings in each zip file. 

Note You need Microsoft Visio 2003 to open the files.

If you need to create new Visio drawings, you can use the Cisco Visio stencils located at the Visio 
Stencils resource page.

Table 7-1 Microsoft Visio Topology Diagrams

Description Filename

Zip file includes the site model topology drawings 
listed below.

IPT_UC601_SiteModels.zip (right-click to download zip) 5.3 MB

Note If you click the link rather than right-click, the zip file may 
open in the secondary window but also replace the contents 
of this window. Use your Back button to return to this 
window.

All test sites in North America Multisite Distributed 
deployment

SiteModel_NorthAmerica_All.vsd

Very Large Campus Clustering over the WAN 
(SJC-RFD) site model

SiteModel_LargeCampus_SJCRFD.vsd

Multi-Site Centralized, Clustering over the WAN 
with Unified SRST (SFO-ORD) site model

SiteModel_MultiCentralized_SFOORD.vsd

Large SIP Site (DFW) site model SiteModel_LargeSIP_DFW.vsd

Medium Business with Remote Locations (AZO) 
site model

SiteModel_MediumBusiness_AZO.vsd

Small Campus Unified Communications Manager 
Site (RXB) site model

SiteModel_SmallUnifiedCM_RXB.vsd

Small Campus SIP Unified Communications 
Manager Express Site (ATL) site model

SiteModel_SmallSIPCME_ATL.vsd

Small Campus H.323 Unified Communications 
Manager Express Site (YYZ) site model

SiteModel_SmallH323CME_YYZ.vsd

Cisco CallManager Release 4.2(3) Interoperability 
Site (NYC) site model

SiteModel_CallManager42Interop_NYC.vsd

Cisco Unified CallManager Release 5.1(1) 
Interoperability Site (RDU) site model

SiteModel_CallManager51Interop_RDU.vsd

All test sites in Europe and Emerging Markets (EUEM) 
Multisite Distributed deployment

SiteModel_EUEM_All.vsd

EUEM Cisco Unified CallManager 
Interoperability Site (LGW) site model

SiteModel_EUEM_UnifiedCMInterop_LGW.vsd

EUEM Medium Site (GVA) site model SiteModel_EUEM_MediumSite_GVA.vsd
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How to Use Microsoft Visio Drawings Efficiently
Microsoft Visio allows you to bring drawings into several applications (for example, Microsoft Word, 
Powerpoint). Unfortunately, the default method is to insert the whole “Visio object” into a file. This can 
cause problems.

When you copy and paste a Visio drawing into another application, the Visio object includes all the 
application data with the drawing. This object information is needed if you want to be able to 
double-click the drawing from Word or Powerpoint and have it open up in Visio for editing. But pasting 

EUEM Large Multisite Centralized with Unified 
SRST (CDG) site model

SiteModel_EUEM_MultiCentral_CDG.vsd

EUEM Small Campus Multisite H.323 (WAW) site 
model

SiteModel_EUEM_MultiH323_WAW.vsd

EUEM Non-Cisco Unified CallManager 
Interoperability Site (RKV) Site model

SiteModel_EUEM_SIPSite_RKV.vsd

EUEM Small Site (MAD) site model SiteModel_EUEM_SmallSite_MAD.vsd

Zip file includes component topology drawings listed 
below.

IPT_UC601_Components.zip (right-click to download zip) 4.2 MB

Note If you click the link rather than right-click, the zip file may 
open in the secondary window but also replace the contents 
of this window. Use your Back button to return to this 
window.

Cisco Unified Communications UC550 configured 
for T.37 fax

UC500_fax.vsd

Cisco Unified Communications UC500 
configuration

UC500.vsd

Cisco TelePresence Multiport Switch Telepresence.vsd

Cisco Unified MeetingPlace Topology in Multisite 
Distributed Deployment

MeetingPlace_Topology.vsd

QSIG connections to Cisco Unified 
Communications Manager clusters

QSIG_UnifiedCM_Clusters.vsd

QSIG connections to Cisco Unified 
Communications Manager Express sites

QSIG_UnifiedCMExpress.vsd

Cisco Unity logical topology Unity_Logical_Topology.vsd

Cisco Unity and Unity Connection physical 
topology - North America

Unity_NA_Site_Topology.vsd

Cisco Unity setup in EUEM test environment Unity_EUEM_Site_Topology.vsd

Cisco Unified CallManager Express integrated 
with Cisco IP-to-IP Gateways

CME_IPIP_Gateways.vsd

Security test topology using Cisco Catalyst 
Firewall Security Module (FWSM)

SecurityTopology_FWSM.vsd

Security test topology using Cisco Adaptive 
Security Appliance (ASA) Firewalls 

SecurityTopology_ASA.vsd

Table 7-1 Microsoft Visio Topology Diagrams (continued)

Description Filename
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as an object adds many megabytes to the size of your file. With only a few such drawings, a Word 
document can bloat from 300 KB to 12 MB, making it troublesome to share among authors or reviewers, 
and a trial for partners or customers to download. (They might even give up before it is done.) In 
addition, very large documents are more problem-prone.

Bringing a Visio Drawing into a Document

Unless you really need the live editing capability, avoid unnecessary file bloat by performing an extra 
step when you paste:

Step 1 In Visio, copy the drawing as you normally do. Tip: Ctrl-C copies the whole drawing.

Step 2 At the desired location in the destination document, choose Edit > Paste Special. In the Paste Special 
dialog box, choose Picture (Windows Metafile). 

Step 3 Click OK. The drawing pastes as an ordinary picture. If it is not positioned properly, choose Format > 
Picture, click the Layout tab and select In line with text. This is generally the most reliable layout 
option.

The Bottom Line

Do not use the paste default (Edit > Paste or Ctrl-V) to paste Visio drawings. Always use Paste Special. 

Downsizing Existing Drawings

If a document is larger than it should be, you can check to see if the Visio drawings are the reason and, 
if so, fix the problem.

Step 1 With the drawing selected in the Word or Powerpoint document, choose Edit. At the bottom of the Edit 
menu, you will see one of the following:

• Edit Object, if the drawing was inserted by simple pasting. It is a Visio object and taking up much 
more file space than it needs to. Go on to step 2. 
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• Edit Picture, if the drawing was inserted properly, as a picture. It is not the source of the large file 
size. 

Step 2 If the drawing is an object, cut it (Ctrl-X), then repaste it as in Bringing a Visio Drawing into a 
Document.

Tip You can easily click through the document to check each picture by using Word's handy Go To feature: 
Where you want to start searching, press Ctrl-G. In the Go to what list, select Graphic and click Next. 
You go to the next graphic. Click it to select, and then check as in step 1. If needed, repaste as in step 2. 
Click Next and continue these steps for other graphics.

Ordering Guides
Ordering guides for most Cisco Unified Communications products are available for partners and Cisco 
employees. For information on ordering guides, go to the following URL:

http://www.cisco.com/web/partners/sell/technology/ipc/announcements/
unified_communications_system_6_launch.html 

Click the “What is available for Partners” tab to view a list of the ordering guides and other marketing 
collaterals.

Troubleshooting Individual Components
See the table IP Telephony Component Troubleshooting Tools and Documentation on the Implement tab 
for individual component troubleshooting information.

Component Resources
Table 7-2 provides links to the main page for documentation on various Cisco Unified Communications 
components, from which you can navigate to individual documents. For documentation on specific 
tasks, see Component Installation and Upgrade and Component Reference Configurations on the 
Implement tab.

Table 7-2 Component Resources Documentation

Category Component Documentation URL

General Voice documentation http://www.cisco.com/en/US/products/sw/voicesw/ts
d_products_support_category_home.html
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Call Control Cisco Unified Communications Manager http://www.cisco.com/en/US/products/sw/voicesw/ps
556/tsd_products_support_series_home.html

Cisco Unified Communications Manager 
Business Edition

http://www.cisco.com/en/US/products/ps7273/tsd_pr
oducts_support_series_home.html

Cisco Unified Communications Manager 
Express

http://www.cisco.com/en/US/products/sw/voicesw/ps
4625/tsd_products_support_series_home.html

Cisco Unified Survivable Remote Site 
Telephony (SRST)

http://www.cisco.com/en/US/products/sw/voicesw/ps
2169/tsd_products_support_series_home.html

Cisco Unified Presence http://www.cisco.com/en/US/products/ps6837/tsd_pr
oducts_support_series_home.html

Cisco Unified Communications 500 Series for 
Small Business

http://www.cisco.com/en/US/products/ps7293/tsd_pr
oducts_support_series_home.html

Contact Center Cisco Customer Response Solutions (Cisco 
Unified Contact Center Express)

http://www.cisco.com/en/US/products/sw/custcosw/p
s1846/tsd_products_support_series_home.html

Applications Cisco Emergency Responder http://www.cisco.com/en/US/products/sw/voicesw/ps
842/tsd_products_support_series_home.html

Cisco Fax Server http://www.cisco.com/en/US/products/ps6178/tsd_pr
oducts_support_series_home.html

Cisco Unified Application Environment http://www.cisco.com/en/US/products/ps7058/tsd_pr
oducts_support_series_home.html

Cisco Unified PhoneProxy http://www.cisco.com/en/US/products/ps7057/tsd_pr
oducts_support_series_home.html

Conferencing Cisco Unified MeetingPlace http://www.cisco.com/en/US/products/sw/ps5664/ps5
669/tsd_products_support_series_home.html

Cisco Unified MeetingPlace Express http://www.cisco.com/en/US/products/ps6533/tsd_pr
oducts_support_series_home.html

Cisco Unified Conferencing for TelePresence http://www.cisco.com/en/US/products/ps7266/tsd_pr
oducts_support_series_home.html

Cisco Unified Videoconferencing http://www.cisco.com/en/US/products/hw/video/ps18
70/tsd_products_support_series_home.html

Voice Mail and 
Unified 
Messaging

Cisco Unity http://www.cisco.com/en/US/products/sw/voicesw/ps
2237/tsd_products_support_series_home.html

Cisco Unity Connection http://www.cisco.com/en/US/products/ps6509/tsd_pr
oducts_support_series_home.html

Cisco Unity Express http://www.cisco.com/en/US/products/sw/voicesw/ps
5520/tsd_products_support_series_home.html

Table 7-2 Component Resources Documentation (continued)

Category Component Documentation URL
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Endpoints and 
Clients

Cisco Unified IP Phone 7900 Series http://www.cisco.com/en/US/products/hw/phones/ps3
79/tsd_products_support_series_home.html

Cisco IP Communicator http://www.cisco.com/en/US/products/sw/voicesw/ps
5475/tsd_products_support_series_home.html

Cisco Unified Personal Communicator http://www.cisco.com/en/US/products/ps6844/tsd_pr
oducts_support_series_home.html

Cisco Unified Video Advantage http://www.cisco.com/en/US/products/sw/voicesw/ps
5662/tsd_products_support_series_home.html

Wireless and 
Mobility

Cisco Aironet 1200 Series Access Points http://www.cisco.com/en/US/products/hw/wireless/ps
430/tsd_products_support_series_home.html

Cisco Unified Mobility Advantage http://www.cisco.com/en/US/products/ps7270/tsd_pr
oducts_support_series_home.html

Cisco Unified Mobile Communicator http://www.cisco.com/en/US/products/ps7271/tsd_pr
oducts_support_series_home.html

Security Cisco ASA 5500 Series Adaptive Security 
Appliances

http://www.cisco.com/en/US/products/ps6120/tsd_pr
oducts_support_series_home.html

Cisco Catalyst 6500 Series Firewall Services 
Module (FWSM)

http://www.cisco.com/en/US/products/hw/modules/ps
2706/ps4452/tsd_products_support_model_home.htm
l

Cisco Catalyst 6500 Series Intrusion Detection 
System (IDSM-2) Module

http://www.cisco.com/en/US/products/hw/modules/ps
2706/ps5058/tsd_products_support_model_home.htm
l

Cisco Intrusion Prevention System Appliance 
IPS-4200

http://www.cisco.com/en/US/products/sw/secursw/ps
2113/tsd_products_support_series_home.html

Cisco NAC Appliance (Clean Access) http://www.cisco.com/en/US/products/ps6128/tsd_pr
oducts_support_series_home.html

Management Center for Cisco Security Agents http://www.cisco.com/en/US/products/sw/secursw/ps
5057/products_installation_and_configuration_guides
_list.html

Cisco Security Agents http://www.cisco.com/en/US/products/sw/secursw/ps
5057/tsd_products_support_series_home.html

Table 7-2 Component Resources Documentation (continued)

Category Component Documentation URL
7-7
Cisco Unified Communications System for IP Telephony Release 6.0(1)

http://www.cisco.com/en/US/products/hw/phones/ps379/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps5475/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6844/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps5662/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/wireless/ps430/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps7270/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps7271/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6120/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/modules/ps2706/ps4452/tsd_products_support_model_home.html
http://www.cisco.com/en/US/products/hw/modules/ps2706/ps5058/tsd_products_support_model_home.html
http://www.cisco.com/en/US/products/sw/secursw/ps2113/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6128/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/secursw/ps5057/products_installation_and_configuration_guides_list.html
http://www.cisco.com/en/US/products/sw/secursw/ps5057/tsd_products_support_series_home.html


Chapter 7      Resource Library
  Component Resources
Network 
Management

Cisco Unified Operations Manager http://www.cisco.com/en/US/products/ps6535/tsd_pr
oducts_support_series_home.html

Cisco Unified Service Monitor http://www.cisco.com/en/US/products/ps6536/tsd_pr
oducts_support_series_home.html

Cisco netManager - Unified Communications http://www.cisco.com/en/US/products/ps7243/tsd_pr
oducts_support_series_home.html

Cisco Unified Service Statistics Manager http://www.cisco.com/en/US/products/ps7285/tsd_pr
oducts_support_series_home.html

Cisco Unified Provisioning Manager http://www.cisco.com/en/US/products/ps7125/tsd_pr
oducts_support_series_home.html

Cisco Monitor Manager http://www.cisco.com/en/US/products/ps7244/tsd_pr
oducts_support_series_home.html

Cisco Monitor Director http://www.cisco.com/en/US/products/ps7246/tsd_pr
oducts_support_series_home.html

CiscoWorks Resource Management Essentials 
(RME)

http://www.cisco.com/en/US/products/sw/cscowork/p
s2073/tsd_products_support_series_home.html

Table 7-2 Component Resources Documentation (continued)

Category Component Documentation URL
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Configuration Command Files
You can download sample configuration files from Table 7-3 for the components described in the 
Component Reference Configurations topic in the Implement tab.

Communications 
Infrastructure

Cisco IOS Software Release 12.4 T http://www.cisco.com/en/US/products/ps6441/tsd_pr
oducts_support_series_home.html

Cisco 1700 Series Modular Access Routers http://www.cisco.com/en/US/products/hw/routers/ps2
21/tsd_products_support_series_home.html

Cisco 2600 Series Routers http://www.cisco.com/en/US/products/hw/routers/ps2
59/tsd_products_support_series_home.html

Cisco 2800 Series Routers/Voice Gateways http://www.cisco.com/en/US/products/ps5854/tsd_pr
oducts_support_series_home.html

Cisco 3700 Series Voice Gateways/Gatekeepers http://www.cisco.com/en/US/products/hw/routers/ps2
82/tsd_products_support_series_home.html

Cisco 3800 Series Routers/Voice Gateways http://www.cisco.com/en/US/products/ps5855/tsd_pr
oducts_support_series_home.html

Cisco 7200 Series Voice Gateways http://www.cisco.com/en/US/products/hw/routers/ps3
41/tsd_products_support_series_home.html

Cisco IP-to-IP Gateways http://www.cisco.com/en/US/products/sw/voicesw/ps
5640/tsd_products_support_series_home.html

Cisco Catalyst 3550 Series Access Switches http://www.cisco.com/en/US/products/hw/switches/p
s646/tsd_products_support_series_home.html

Cisco Catalyst 3560 Series Access Switches http://www.cisco.com/en/US/products/hw/switches/p
s5528/tsd_products_support_series_home.html

Cisco Catalyst 3750 Series Data Center 
Switches

http://www.cisco.com/en/US/products/hw/switches/p
s5023/tsd_products_support_series_home.html

Cisco Catalyst 4500 Series Access Switches http://www.cisco.com/en/US/products/hw/switches/p
s4324/tsd_products_support_series_home.html

Cisco Catalyst 6500 Series Switches http://www.cisco.com/en/US/products/hw/switches/p
s708/tsd_products_support_series_home.html

Cisco Catalyst 6600 Series Voice Gateways http://www.cisco.com/en/US/products/hw/switches/p
s700/tsd_products_support_eol_series_home.html

Cisco VG224/248 Analog Voice Gateways http://www.cisco.com/en/US/products/hw/gatecont/ps
2250/tsd_products_support_series_home.html

Cisco ATA 186,188 (analog telephone adaptor) http://www.cisco.com/en/US/products/hw/gatecont/ps
514/tsd_products_support_series_home.html

Table 7-2 Component Resources Documentation (continued)
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Table 7-3 Configuration Command Files

Description Filename

Zip file includes Cisco device configurations listed below:

Note Some parameters, such as passwords, have been removed 
from the configuration files for security reasons.

IPT_UC601_Reference_Configs.zip (right-click to 
download zip) includes the files below.

Note If you click the link rather than right-click, the zip 
file may open in the secondary window but also 
replace the contents of this window. Use your 
Back button to return to this window.

Cisco Unified Communications Manager Express on a Cisco 
3845 (ALT-CME-3845-3)

ATL_3845.txt

Cisco Unified Communications Manager Express on a Cisco 
2651 (YYZ-CME-3745-1)

YYZ_Config.txt

Cisco Unified Communications Manager Express on a Cisco 
3725 with SIP and SCCP configured (Covington-3725-CME)

Covington-SIP-SCCP.txt

Cisco Unified Communications Manager Express on a Cisco 
2801 with SIP configured (Ely-2801-CME)

ELY-PureSIP.txt

Cisco Unified Communications Manager Express on a Cisco 
2801 with SCCP configured (Robins-2801-GW)

Robins-PureSCCP.txt

Cisco Unity Express on a Cisco 3745 (YYZ-CUE-3745) CUE_3745_Config.txt

Cisco Catalyst switch Firewall Service Module 
(SJC-RFD-FWSM-1)

FWSM_Config.txt

Cisco 3745 primary gatekeeper (SJC-RFD-GK-1) Gatekeeper_Primary_Config.txt

Cisco 3745 alternate gatekeeper (SJC-RFD-GK-2) Gatekeeper_Alternate_Config.txt

Gatekeeper configured as first gatekeeper in a cluster 
(SJC-RFD-VID-GK-1)

Gatekeeper_FirstinCluster_Config.txt

Gatekeeper configured as second gatekeeper in a cluster 
(SJC-VIDEO-GK-2)

Gatekeeper_SecondinCluster_Config.txt

IP-IP gateway configured for Cisco Unified Communications 
Manager to IP-IP gateway SIP trunks (ATL-IPIPGW)

ATL-IPIPGW.txt

Inter-cluster calls from Cisco Unified Communications 
Manager Express to Cisco Communications Manager via 
IP-IP gateway (Robins-IPIP-GW)

Robins-IPIPGW-config.txt

Cisco 3745 SIP gateway (DFW-3745GW) SIPGW_3745_Config.txt

Cisco Catalyst 6500 switch (CDG_CMM-GW_1) configured 
for QSIG links

QSIG_Cat6500_Config.txt

Cisco Unified SRST for H.323 gateway on a Cisco 2851 
(HNL1-SRST-2851)

hnl1-srst-2581-confg.txt

Cisco Unified SRST for MGCP gateway on a Cisco 2691 
(HNL2-SRST-2691)

hnl2-srst-2691-confg.txt

Cisco Aironet WLAN Controller wlan-controller.txt
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System Test Results
This topic summarizes the results of Cisco Unified Communications Release 6.0(1) system testing for 
IP telephony environments. This topic contains the following sections:

• Testing Objectives

• Tested Deployment and Site Models

• Test Results

Testing Objectives
Cisco Systems validates Cisco Unified Communications systems by designing, installing, configuring, 
and testing hardware and software to achieve a predictable, effective, and reliable system. The intent of 
system testing is to validate the seamless interoperability and stability of the components that make up 
a complete and optimized Cisco Unified Communications system.

Testing performed for Cisco Unified Communications includes (but is not limited to) the following:

• Installation, Upgrade, and Usability Testing—To verify software installation and upgrades at the 
system level and usability for system components 

• End-to-End Functionality Testing—To verify the end-to-end functionality of system components

• Basic Functionality and Feature Testing—To verify basic call flows and component features

• Customer Assurance Program (CAP) Scenario Testing—To re-create and test CAP scenarios based 
on TAC input

• Interoperability Testing—To verify the interoperability among system components

• Scalability Testing—To verify system functionality during scalability tests

• Performance, Load, and Stress Testing—To verify system functionality during performance, load, 
and stress tests

• Failover, Recovery, and Redundancy Testing—To verify system behavior during failover and 
recovery, and behavior in redundant configurations

Tested Deployment and Site Models
Cisco Unified Communications Release 6.0(1) testing for IP telephony was designed to test the hardware 
and software components that work together in a multi-site distributed IP telephony deployment. For this 
testing, several site models were created. Each site model was designed to test a specific set of features 
and interactions. For information about the components, configurations, and environment tested in Cisco 
Unified Communications Release 6.0(1), see Tested Deployments and Site Models.

Test Results
The results of the system tests performed for IP telephony during Cisco Unified Communications 
Release 6.0(1) are shown in the System Test Results (right-click to download PDF).

The test results contain the following information:

• Title—Title of the test.
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• ID—Identifier for the test.

• Description—Description of the purpose of the test.

• Features Tested—Component feature tested.

• Status—Result of the test and any defects related to the test case. Possible values are:

– Passed—Test case passed as described in the table.

– Failed—Test case failed and the reason is described in the listed defect.

– Passed with exception—Test case as described passed but an anomaly occurred that was not 
directly related to the functionality being tested. Possible anomalies are as follows: 

The test steps were modified based on the actual feature implementation.

The test setup was modified based on the actual feature implementation.

The test results did not exactly match what was expected although the feature performed as 
required. 

• Defects—Identifier for any defect that was opened against the test. If you have an account with 
Cisco.com, you can use the Bug Toolkit to view information about defects.

To access the Bug Toolkit, go to this URL:

– http://www.cisco.com/cgi-bin/Support/Bugtool/launch_bugtool.pl

End-of-Sale and End-of-Life Products
The end-of-sale (EOS) date is the last date to order the product through Cisco point-of-sale mechanisms. 
The product is no longer for sale. There is also an end-of-life (EOL) process that guides the final 
business operations associated with the product life cycle.

The EOL process consists of a series of technical and business milestones and activities that, once 
completed, make a product obsolete. Once obsolete, the product is not sold, manufactured, improved, 
repaired, maintained, or supported.

For information about recommended replacements, see the comprehensive list of announcements at the 
following URL:

http://www.cisco.com/en/US/products/prod_end_of_life.html

For information on specific products, choose a product from the following URL:

http://www.cisco.com/en/US/products/sw/voicesw/index.html

Then click on the End-of-Life and End-of-Sale Notices link in the Product Literature box.

For an overview of the Products and Services EOL policy, see the information at the following URL:

http://www.cisco.com/en/US/products/products_end-of-life_policy.html

Cisco Unified Communications System Demo
The Cisco Unified Communications system demonstration document is for Cisco sales teams and 
describes the various methods available to demonstrate the Cisco Unified Communications System.

• Cisco Unified Communications System Demo (INTERNAL)
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